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The MSP-EXP430FR2433 LaunchPad™ Development Kit is an easy-to-use evaluation module (EVM)
based on the MSP430FR2433 Value Line Sensing microcontroller (MCU). It contains everything needed
to start developing on the ultra-low-power MSP430FR2x Value Line Sensing MCU platform, including
onboard debug probe for programming, debugging, and energy measurements. The board includes two
buttons and two LEDs for creating a simple user interface. It also supports using a supercapacitor (must
be purchased and installed by the user) that acts like a rechargeable battery, enabling stand-alone
applications without an external power supply.

Figure 1 shows the MSP-EXP430FR2433 LaunchPad development kit.

Figure 1. MSP-EXP430FR2433 LaunchPad Development Kit
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1 Getting Started

1.1 Introduction
The 16-MHz MSP430FR2433 device features 15.5KB of embedded FRAM (ferroelectric random access
memory), a nonvolatile memory known for its ultra-low power, high endurance, and high-speed write
access. Combined with the 4KB of on-chip SRAM, users have access to 15.5KB of memory to split
between their program and data as required. For example, a data logging application may require a large
data memory with a relatively small program memory, so the memory may be allocated as required
between program and data memory.

Rapid prototyping is simplified by the 20-pin BoosterPack™ plug-in module headers, which support a wide
range of available BoosterPack modules. You can quickly add features like wireless connectivity, graphical
displays, environmental sensing, and much more. Design your own BoosterPack plug-in module or
choose among many already available from TI and third-party developers.

Free software development tools are also available, such as TI's Eclipse-based Code Composer Studio™
IDE (CCS) and IAR Embedded Workbench® IDE. Both of these IDEs support EnergyTrace™ technology
for real-time power profiling and debugging when paired with the MSP430FR2433 LaunchPad
development kit.

1.2 Key Features
• MSP ULP FRAM technology based MSP430FR2433 16-bit MCU
• EnergyTrace Technology available for ultra-low-power debugging
• 20-pin LaunchPad development kit standard leveraging the BoosterPack plug-in module ecosystem
• Onboard eZ-FET debug probe
• 2 buttons and 2 LEDs for user interaction

1.3 What's Included

1.3.1 Kit Contents
• 1 MSP-EXP430FR2433 LaunchPad development kit
• 1 Micro USB cable
• 1 Quick start guide
• The supercapacitor is not included and must be provided by the user

1.3.2 Software Examples
• Out-of-Box Software

http://www.ti.com
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1.4 First Steps: Out-of-Box Experience
An easy way to get started with the EVM is by using its preprogrammed out-of-box code. This code
demonstrates some key features of the EVM.

1.4.1 Connecting to the Computer
Connect the LaunchPad development kit to a computer using the included USB cable. A green power LED
should illuminate. For proper operation, drivers are needed. It is recommended to get drivers by installing
an IDE such as TI's CCS or IAR EW430. Drivers are also available at www.ti.com/MSPdrivers.

1.4.2 Running the Out-of-Box Demo
The out-of-box (OOB) demo for the MSP-EXP430FR2433 LaunchPad development kit demonstrates how
to setup a periodic temperature data logger, by using a ring buffer inside the FRAM memory of the
MSP430FR2433 MCU. Alternatively, the demo also implements a real-time temperature sensor.

Both the logged and the real-time temperature data can be transmitted to the PC and visualized using the
accompanying cloud GUI (visit MSP-EXP430FR2433 OOB GUI). If access to the cloud GUI is not
available, the data can still be observed using any serial terminal application (application UART settings:
115200, 8, 1, n).

By default after power up, the LaunchPad development kit enters the FRAM Data Log mode. The red
LED1 blinks periodically (approximately every 5 seconds), which indicates that the device is waking up to
log the temperature and going back to sleep. Press the left user button S1 to transfer the stored
temperature to the PC.

Next, try pressing the S1 and S2 buttons simultaneously to enter the Live Temperature mode. The
LaunchPad development kit should start streaming live temperature data to the PC to be visualized in the
MSP-EXP430FR2433 OOB GUI or displayed in a serial terminal. In this mode, the application also keeps
track of a temperature threshold (the default is 25°C), and when a new temperature data is acquired, it is
compared against that threshold. If the current temperature is above the threshold, the red LED1
illuminates, and if the current temperature is below the threshold, the green LED2 illuminates. Pressing S1
or S2 independently increases or decreases the temperature threshold in this mode.

The user can influence the temperature of the device by blowing hot or cold air and observing the
changes in the user LED brightness or see data changes on the GUI.

1.5 Next Steps: Looking Into the Provided Code
After the EVM features have been explored, the fun can begin. It is time to open an integrated
development environment and start editing the code examples. See Section 4 for available IDEs and
where to download them.

The quickest way to get started using the LaunchPad development kit is to use TI's Cloud Development
Tools. The cloud-based Resource Explorer provides access to all of the examples and resources in
MSPWare software. Code Composer Studio Cloud is a simple cloud-based IDE that enables developing
and running applications on the LaunchPad development kit.

The out-of-box source code and more code examples are provided and available on the download page.
Code is licensed under BSD, and TI encourages reuse and modifications to fit specific needs.

Section 3 describes all functions in detail and provides a project structure to help familiarize you with the
code.

With the onboard eZ-FET debug probe debugging and downloading new code is simple. A USB
connection between the EVM and a PC through the provided USB cable is all that is needed.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/MSPdrivers
https://dev.ti.com/gallery/view/3491167/MSP-EXP430FR2433_OOB_GUI/
http://dev.ti.com/
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Target device 
MSP430FR2433

Crystal 
32.768 kHz

Micro-B 
USB

3.3-V LDO

ESD 
Protection

Debug 
MCU

LED 
Red, Green

Crystal, 
4 MHz

UART, SBW to Target

User interface
2 buttons, 2 LEDs

20-pin 
LaunchPad 

standard headers

Power to Target

Reset 
button

EnergyTrace
Technology

Supercapacitor

www.ti.com Hardware

5SLAU739–October 2017
Submit Documentation Feedback

Copyright © 2017, Texas Instruments Incorporated

MSP430FR2433 LaunchPad™ Development Kit (MSP‑EXP430FR2433)

2 Hardware
Figure 2 shows an overview of the MSP-EXP430FR2433 hardware.

Figure 2. MSP-EXP430FR2433 Overview

2.1 Block Diagram
Figure 3 shows the block diagram.

Figure 3. MSP-EXP430FR2433 Block Diagram
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2.2 Hardware Features

2.2.1 MSP430FR2433 MCU
The MSP430FR2433 is an ultra-low-power MSP430FRx FRAM-based microcontroller (MCU), which offer
extended data logging and security capabilities. The MSP430FR2433 offers the small VQFN package
(4 mm × 4 mm) in the FRAM microcontroller portfolio, combined with a variety of integrated peripherals
and ultra-low power consumption. FRAM is a cutting edge memory technology, combining the best
features of flash and RAM into one nonvolatile memory. More information on FRAM can be found at
www.ti.com/fram.

Device features include:
• 1.8-V to 3.6-V operation
• 16-bit RISC architecture up to 16-MHz system clock and 8-MHz FRAM access
• 15KB of program FRAM, 512B of information FRAM, and 4KB of RAM
• 8-channel 10-bit ADC
• Four 16-Bit timers

– Two timers with three capture/compare registers each (Timer_A3)
– Two timers with two capture/compare registers each (Timer_A2)

• 32-bit hardware multiplier (MPY)
• 19 GPIOs
• Two enhanced universal serial communication interfaces (eUSCI_A) support UART, IrDA, and SPI
• One eUSCI (eUSCI_B) supports SPI and I2C

Figure 4. MSP430FR2433 Pinout

http://www.ti.com
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2.2.2 eZ-FET Onboard Debug Probe With EnergyTrace Technology
To keep development easy and cost effective, TI's LaunchPad development kits integrate an onboard
debug probe, which eliminates the need for expensive programmers. The MSP-EXP430FR2433 has the
eZ-FET debug probe (see Figure 5), which is a simple and low-cost debugger that supports all MSP430™
device derivatives.

Figure 5. eZ-FET Debug Probe

The MSP-EXP430FR2433 LaunchPad development kit features EnergyTrace technology but does not
have support for EnergyTrace++ technology. The EnergyTrace functionality varies across the MSP
portfolio.

Table 1. EnergyTrace Technology

Features EnergyTrace Technology EnergyTrace++ Technology
Current monitoring Yes Yes
CPU state No Yes
Peripheral and system state No Yes

Devices supported All MSP430 MCUs MSP430FR59xx and
MSP430FR69xx MCUs

Development tool required MSP-FET or eZ-FET MSP-FET or eZ-FET

The dotted line through J101 shown in Figure 5 divides the eZ-FET debug probe from the target area. The
signals that cross this line can be disconnected by jumpers on J101, the isolation jumper block. For more
details on the isolation jumper block, see Section 2.2.3.

The eZ-FET also provides a backchannel UART-over-USB connection with the host, which can be very
useful during debugging and for easy communication with a PC. For more details, see Section 2.2.4.

The eZ-FET hardware can be found in the schematics in Section 6 and in the MSP-EXP430FR2433
design files download page. The software and more information about the debugger can be found on the
eZ-FET wiki. More information on the eZ-FET can be found in the MSP Debuggers User's Guide.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/tool/MSP-EXP430FR2433
http://www.ti.com/tool/MSP-EXP430FR2433
http://www.ti.com/lit/pdf/slau647
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2.2.3 Debug Probe Connection: Isolation Jumper Block
The isolation jumper block at jumper J101 allows the user to connect or disconnect signals that cross from
the eZ-FET domain into the MSP430FR2433 target domain. This includes eZ-FET Spy-Bi-Wire signals,
application UART signals, and 3.3-V and 5-V power. Table 2 describes these connections.

Reasons to open these connections:
• To remove any and all influence from the eZ-FET debug probe for high accuracy target power

measurements
• To control 3-V and 5-V power flow between the eZ-FET and target domains
• To expose the target MCU pins for other use than onboard debugging and application UART

communication
• To expose the programming and UART interface of the eZ-FET so that it can be used for devices other

than the onboard MCU. See Section 2.6 for how to use the eZ-FET Debug Probe with a different
target.

Table 2. Isolation Block Connections

Jumper Description
GND Ground
5V 5-V VBUS from USB
3V3 3.3-V rail, derived from VBUS in the eZ-FET domain

RXD << Backchannel UART: The target FR2433 receives data through this signal. The arrows indicate the
direction of the signal.

TXD >> Backchannel UART: The target FR2433 sends data through this signal. The arrows indicate the direction
of the signal.

SBW RST Spy-Bi-Wire debug: SBWTDIO data signal. This pin also functions as the RST signal (active low).
SBW TST Spy-Bi-Wire debug: SBWTCK clock signal. This pin also functions as the TST signal.

Figure 6. eZ-FET Isolation Jumper Block Diagram

http://www.ti.com
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2.2.4 Application (or Backchannel) UART
The backchannel UART allows communication with the USB host that is not part of the target application's
main functionality. This is very useful during development, and also provides a communication channel to
the PC host side. This can be used to create graphical user interfaces (GUIs) and other programs on the
PC that communicate with the LaunchPad.

Figure 6 shows the pathway of the backchannel UART. The backchannel UART is the UART on
eUSCI_A0.

On the host side, a virtual COM port for the application backchannel UART is generated when the
LaunchPad enumerates on the host. You can use any PC application that interfaces with COM ports,
including terminal applications like Hyperterminal or Docklight, to open this port and communicate with the
target application. You need to identify the COM port for the backchannel. On Windows PCs, Device
Manager can assist.

Figure 7. Application Backchannel UART in Device Manager

The backchannel UART is the MSP Application UART1 port. In this case, Figure 7 shows COM13, but this
port can vary from one host PC to the next. After you identify the correct COM port, configure it in your
host application according to its documentation. You can then open the port and begin communication to it
from the host.

On the target MSP430FR2433 side, the backchannel is connected to the eUSCI_A0 module. The eZ-FET
has a configurable baud rate; therefore, it is important that the PC application configures the baud rate to
be the same as what is configured on the eUSCI_A0.

2.2.5 Optional Features

2.2.5.1 Supercapacitor
A through-hole component footprint is available on the board and allows user to populate a supercapacitor
to power the system without any external power. The recommended part is the Panasonic EEC-
S0HD224H 220 mF (0.22 F) supercapacitor and can be purchased from major electronic component
distributers.

NOTE: A supercapacitor is not included in the kit and must be supplied by the user.

Using the onboard jumper headers, the supercapacitor can configured in the following ways: charging,
using (direct connection to 3V3 rail), or disconnected. For more details on these use modes and how to
use them, see Section 2.3.

http://www.ti.com
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2.3 Power
The board was designed to accommodate various powering methods, including through the onboard eZ-
FET as well as from external or BoosterPack power. Figure 8 shows power from the ez-FET and power
from external source through header J5 or the BoosterPack module.

Figure 8. MSP-EXP430FR2433 Power Block Diagram

2.3.1 eZ-FET USB Power
The most common power-supply scenario is from USB through the eZ-FET debugger. This provides 5-V
power from the USB and also regulates this power rail to 3.3 V for eZ-FET operation and 3.3 V to the
target side of the LaunchPad. Power from the eZ-FET is controlled by jumper J101. For 3.3 V, make sure
that a jumper is connected across the J101 3V3 terminal.

2.3.2 BoosterPack and External Power Supply
Header J5 is present on the board to supply external power directly. It is important to comply with the
device voltage operation specifications when supplying external power. The MSP430FR2433 has an
operating range of 1.8 V to 3.6 V. More information can be found in the MSP430FR2433 Mixed-Signal
Microcontroller data sheet.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
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2.3.3 Supercap (C6)
If the supercapacitor is populated, it can be used to evaluate the ultra-low power feature of the
MSP430FR2433 target device. See how long you can run your application on the supercap alone.

NOTE: A supercapacitor is not included in the kit and must be supplied by the user.

Figure 9 shows charging the supercap and powering directly from it.

Figure 9. MSP-EXP430FR2433 Supercap Power Block Diagram

2.3.3.1 Charging the Supercap
The supercapacitor can be charged when the EVM is plugged into the PC or when the board is externally
powered. During charging, set J4 to the “Charge” setting, this adds in a current limiting resistor for
charging.

To charge the supercap, power must be coming from the eZ-FET debug probe, external power through
J5, or a BoosterPack module powering through J1. Allow two to three minutes for the supercap to charge
(time may vary depending on initial charge of the supercap and your power source) to full VCC.

2.3.3.2 Using the Supercap
After charging of the supercapacitor, you can move the J4 jumper to the Use setting and then unplug
power. This connects the supercapacitor to the 3V3 rail without the charging resistor in between. At this
point, the LaunchPad kit is being powered completely by the C6 supercapacitor.

For lowest power operation, make sure to disconnect the J101 jumpers so that the eZ-FET is not also
powered by the C6 supercap.

2.3.3.3 Disabling the Supercap
The supercapacitor can be completely decoupled from the board by removing the J4 jumper. Hanging this
jumper off only one pin can prevent losing the jumper.

http://www.ti.com
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2.4 Measure Current Draw of the MSP430 MCU
To measure the current draw of the MSP430FR2433 using a multimeter, use the 3V3 jumper on the J101
jumper isolation block. The current measured includes the target device and any current drawn through
the BoosterPack headers.

To measure ultra-low power, follow these steps:
1. Remove the 3V3 jumper in the J101 isolation block, and attach an ammeter across this jumper.
2. Consider the effect that the backchannel UART and any circuitry attached to the MSP430FR2433 may

have on current draw. Consider disconnecting these at the isolation jumper block, or at least consider
their current sinking and sourcing capability in the final measurement.

3. Make sure there are no floating inputs/outputs (I/Os) on the MSP430FR2433. These cause
unnecessary extra current draw. Every I/O should either be driven out or, if it is an input, should be
pulled or driven to a high or low level.

4. Begin target execution.
5. Measure the current. Keep in mind that if the current levels are fluctuating, it may be difficult to get a

stable measurement. It is easier to measure quiescent states.

EnergyTrace can also be used to compare various current profiles and better optimize your energy
performance!

2.5 Clocking
The MSP-EXP430FR2433 provides external clocks in addition to the internal clocks in the device.
• Q1: 32-kHz Epson crystal (FC-135R) 12.5-pF crystal, part number: X1A0001410014

The 32-kHz crystal allows for lower LPM sleep currents than do the other low-frequency clock sources.
Therefore, the presence of the crystal allows the full range of low-power modes to be used.

By default, the crystal is not connected to the MSP430FR2433 because the target pins are multiplexed
with 2 BoosterPack header pins. 0-Ω resistors R4 and R5 need to be removed, while R2 and R3 must be
shorted across, to connect the external crystal to the MSP430FR2433. See the onboard crystal selection
resistors silkscreen for how to configure the resistors to select between the crystal or the BoosterPack
pins.

The internal clocks in the device default to the following configuration:
• MCLK: DCO 1 MHz
• SMCLK: DCO 1 MHz
• ACLK: REFO 32.768 kHz

For more information about configuring internal clocks and using the external oscillators, see the
MSP430FR4xx and MSP430FR2xx Family User's Guide.

2.6 Using the eZ-FET Debug Probe With a Different Target
The eZ-FET debug probe on the LaunchPad can interface to most MSP430 derivative devices, not just the
onboard MSP430FR2433 target device.

To do this, disconnect every jumper in the isolation jumper block. This is necessary, because the debug
probe cannot connect to more than one target at a time over the Spy-Bi-Wire (SBW) connection.

Next, make sure the target board has proper connections for SBW. To be compatible with SBW, the
capacitor on RST/SBWTDIO cannot be greater than 2.2 nF. The documentation for designing MSP430
JTAG interface circuitry is the MSP430 Hardware Tools User's Guide.

Finally, wire together these signals from the debug probe side of the isolation jumper block to the target
hardware:
• 5 V (if 5 V is needed)
• 3.3 V
• GND
• SBWTDIO

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/lit/pdf/SLAU445
http://www.ti.com/lit/pdf/SLAU278
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• SBWTCK
• TXD (if the UART backchannel is to be used)
• RXD (if the UART backchannel is to be used)

This wiring can be done either with jumper wires or by designing the board with a connector that plugs into
the isolation jumper block.

2.7 BoosterPack Pinout
The LaunchPad kit adheres to the 20-pin LaunchPad pinout standard. A standard was created to aid
compatibility between LaunchPad kits and BoosterPack modules across the TI ecosystem.

While most BoosterPack modules are compliant with the standard, some are not. The MSP-
EXP430FR2433 LaunchPad kit is compatible with all 20-pin BoosterPack modules that are compliant with
the standard. If the reseller or owner of the BoosterPack module does not explicitly indicate compatibility
with the MSP-EXP430FR2433 LaunchPad development kit, compare the schematic of the candidate
BoosterPack module with the LaunchPad kit to ensure compatibility. Keep in mind that sometimes
conflicts can be resolved by changing the MSP430FR2433 device pin function configuration in software.

Figure 10. BoosterPack Checker Tool

To check the compatibility of your desired BoosterPack modules for your design, with a LaunchPad kit of
your choice, you can use the BoosterPack Checker tool. This allows you to select any LaunchPad kit that
TI offers and determine its compatibility with any number of BoosterPack modules. You can also add your
own BoosterPack module to check its compatibility as you prototype that next design.

Figure 11 shows the 20-pin pinout of the MSP430FR2433 LaunchPad development kit.

The inner side of the dashed line shows some of the software selectable functions on each pin, including
the functions that conform to the standard. However, each pin may have other functionalities that can be
configured by the software. See the MSP430FR2433 data sheet for more details on individual pin
functions.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/lit/pdf/slase59
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Figure 11. LaunchPad Kit to BoosterPack Module Connector Pinout

2.8 Design Files

2.8.1 Hardware
Section 6 shows the schematics. All design files including schematics, layout, bill of materials (BOM),
Gerber files, and documentation are available on the MSP-EXP430FR2433 design files download page.

2.8.2 Software
All design files including TI-TXT object-code firmware images, software example projects, and
documentation are available on the MSP-EXP430FR2433 design files download page.

2.9 Hardware Change log
Table 3 lists the revision history of the MSP-EXP430FR2433 hardware.

Table 3. Hardware Change Log

PCB Revision Description
Rev 1.0 Initial release

3 Software Examples
Four software examples are included with the MSP430FR2433 LaunchPad development kit (see Table 4),
which can be found in the MSP430FR2433 LaunchPad development kit download page and are also
available inside the MSPWare software.

Table 4. Software Examples

Demo Name BoosterPack
Required Description More Details

OutOfBox_FR2433 None The out-of-box demo preprogrammed on the LaunchPad kit from the
factory. Demonstrates features of MSP430FR2433 device Section 3.1

BlinkLED_FR2433 None Blinks an LED on the LaunchPad kit at a fixed interval Section 3.2

To use any of the software examples with the LaunchPad development kit, you must have an integrated
development environment (IDE) that supports the MSP430FR2433 device (see Table 5).

Table 5. IDE Minimum Requirements for MSP-EXP430FR2433

Code Composer Studio IDE IAR Embedded Workbench for Texas
Instruments MSP430 IDE

Version 6.1.3 or later Version 6.30 or later

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/tool/MSP-EXP430FR2433
http://www.ti.com/tool/MSP-EXP430FR2433
http://www.ti.com/tool/MSP-EXP430FR2433
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For more details on how to get started quickly, and where to download the latest CCS and IAR IDEs, see
Section 4.

3.1 Out-of-Box Software Example
This section describes the functionality and structure of the out-of-box software that is preloaded on the
EVM.

The Out-of-Box demo for the MSP-EXP430FR2433 LaunchPad development kit demonstrates how to
setup a periodic temperature data logger, by using a ring-buffer inside the FRAM memory of the
MSP430FR2433 MCU. The demo also implements a real-time temperature sensor.

3.1.1 Source File Structure
The project is split into multiple files (see Table 6). This makes it easier to navigate and reuse parts of it
for other projects.

Table 6. Source File and Folders

Name Description
main.c Out-of-Box demo main function

FRAMLogMode.c Contains functions for the FRAM data logging mode
LiveTempMode.c Contains function for the live temperature streaming mode
Library: driverlib Device driver library

Library: fram-utilities Contains the CTPL and NVS software libraries from the FRAM Utilities
Library: iqmathlib Fixed Point Math Library for MSP

Library: jsmn Third-party library for parsing JSON formatted strings

3.1.2 Overview
An online cloud GUI (MSP-EXP430FR2433 OOB GUI) can be used to download this demo to your board
and visualize the temperature data. A serial terminal can also be used to display the data being sent from
the demo to the PC (application UART settings: 115200, 8, 1, n).

Upon powering up the Out-of-Box demo, the green LED2 lights up for 1 second, and then the board
enters FRAM data logging mode to measure and record the internal temperature of the MSP430FR2433
MCU every 5 seconds.

By default after power up, the LaunchPad development kit enters the FRAM data logging mode. At any
time, press the S1 and S2 buttons simultaneously to switch between the live temperature mode and the
FRAM data logging mode.

3.1.3 FRAM Data Logging Mode
This mode shows the FRAM data logging capabilities of the MSP430FR2433. After starting this mode, the
LaunchPad wake up from LPM3.5 approximately every 5 seconds (indicated by short red LED1 blink) to
log temperature values. Data are stored into a ring buffer located in the FRAM memory. When the ring
buffer fills up to its capacity, the oldest temperature data is discarded and replaced with the newest data.
• Press the left button S1 to transfer all data stored inside the ring buffer to the PC.
• Press the right button S1 to clear all data and return to an empty ring buffer.
• The compute through power loss (CTPL) and nonvolatile storage (NVS) libraries from the FRAM

Utilities are used in this demo to simplify the code to setup this simple data logging application.

3.1.4 Live Temperature Mode
In this mode, the LaunchPad kit repeatedly measures the internal temperature of the MSP430FR2433
MCU and transfers the data to the PC through UART.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
https://dev.ti.com/gallery/view/3491167/MSP-EXP430FR2433_OOB_GUI/
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The application also keeps track of a temperature threshold in this mode (default is 25°C), and when a
new temperature data is acquired, it is compared against the threshold. If measured temperature is below
the threshold, the green LED2 illuminates, and if the measured temperature is above the threshold, the
red LED1 illuminates.

Independently pressing S1 or S2 increases or decreases, respectively, the temperature threshold in this
mode. The further the recorded temperature is from the threshold, the brighter the corresponding LEDs
illuminate.

The user can influence the temperature of the device by blowing hot or cold air and observing the
changes in the user LED brightness or see data changes on the GUI.

3.2 Blink LED Example
This very simple software example shows how to software toggle a GPIO to blink an LED on the
LaunchPad kit.

3.2.1 Source File Structure
The project is split into multiple files (see Table 7). This makes it easier to navigate and reuse parts of it
for other projects.

Table 7. Source File and Folders

Name Description
main.c The Blink LED main function

Library: Driverlib Device driver library

The main code simply uses the MSP430 Driver Library to halt the watchdog timer and to configure and
toggle the P1.0 GPIO pin connected to the LED inside a software loop.

4 Resources

4.1 Integrated Development Environments
Although the source files can be viewed with any text editor, more can be done with the projects if they
are opened with a development environment like Code Composer Studio IDE and IAR Embedded
Workbench IDE.

4.1.1 TI Cloud Development Tools
TI's Cloud-based software development tools provide instant access to MSPWare content and a web-
based IDE.

4.1.1.1 TI Resource Explorer Cloud
TI Resource Explorer Cloud provides a web interface for browsing examples, libraries and documentation
found in MSPWare without having to download files to your local drive (see Figure 12).

Visit TI Resource Explorer Cloud now at dev.ti.com.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/tool/msp430driverlib
http://dev.ti.com/
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Figure 12. TI Resource Explorer Cloud

4.1.1.2 Code Composer Studio Cloud
Code Composer Studio Cloud (CCS Cloud) is a web-based IDE that enables you to quickly create, edit,
build and debug applications for your LaunchPad development kit. No need to download and install large
software packages, simply connect your LaunchPad development kit and begin. You can choose to select
from a large variety of examples in MSPWare software and Energia or develop your own application. CCS
Cloud supports debug features such as execution control, breakpoints and viewing variables.

For a full comparison between CCS Cloud and CCS Desktop, visit the TI Cloud Tools page.

Visit Code Composer Studio Cloud now at dev.ti.com.

Figure 13. CCS Cloud

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
https://dev.ti.com/about#cloudordesktop
http://dev.ti.com/
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4.1.2 Code Composer Studio IDE
Code Composer Studio Desktop is a professional integrated development environment that supports TI's
Microcontroller and Embedded Processors portfolio. Code Composer Studio comprises a suite of tools
used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source code
editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS and download it at www.ti.com/tool/ccstudio.

CCS v7.0.0 or higher is required. When CCS has been launched, and a workspace directory chosen, use
Project>Import Existing CCS Eclipse Project. Direct it to the desired demo's project directory that contains
main.c.

Figure 14. Directing the Project>Import Function to the Demo Project

Selecting the \CCS subdirectory also works. The CCS-specific files are located there.

When you click OK, CCS should recognize the project and allow you to import it. The indication that CCS
has found it is that the project appears in the box shown in Figure 15, and it has a checkmark to the left of
it.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/tool/ccstudio
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Figure 15. When CCS Has Found the Project

Sometimes CCS finds the project but does not show a checkmark; this might mean that your workspace
already has a project by that name. You can resolve this by renaming or deleting that project. (Even if you
do not see it in the CCS workspace, be sure to check the workspace directory on the file system.)

4.1.3 IAR Embedded Workbench for Texas Instruments 430
IAR Embedded Workbench for MSP430 is another very powerful integrated development environment that
allows you to develop and manage complete embedded application projects. It integrates the IAR C/C++
Compiler, IAR Assembler, IAR ILINK Linker, editor, project manager, command line build utility, and IAR
C-SPY® Debugger.

Learn more about IAR Embedded Workbench for MSP430 and download it at
supp.iar.com/Download/SW/?item=EW430-EVAL.

IAR 6.30 or higher is required. To open the demo in IAR, click File>Open>Workspace…, and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project….

Although the software examples have all of the code required to run them, IAR users may download and
install MSPWare, which contains MSP430 libraries and the TI Resource Explorer. These are already
included in a CCS installation (unless the user selected otherwise).

4.2 LaunchPad Websites
More information about the LaunchPad development kit, supported BoosterPack plug-in modules, and
available resources can be found at:
• MSP-EXP430FR2433 Tool Folder: Resources specific to this particular LaunchPad development kit
• TI's LaunchPad portal: Information about all LaunchPad development kits from TI

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://supp.iar.com/Download/SW/?item=EW430-EVAL
http://www.ti.com/tool/msp-exp430fr2433
http://www.ti.com/launchpad
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4.3 MSPWare and TI Resource Explorer
TI Resource Explorer is a tool integrated into CCS that allows you to browse through available design
resources. TI Resource Explorer helps you quickly find what you need inside packages including
MSPWare, ControlSuite, TivaWare, and more. TI Resource Explorer is well organized to find everything
that you need quickly, and you can import software projects into your workspace in one click.

TI Resource Explorer Cloud is one of the TI Cloud Development tools and is tightly integrated with CCS
Cloud. See Section 4.1.1 for more information.

MSPWare is a collection of code examples, software libraries, data sheets, and other design resources for
all MSP devices delivered in a convenient package – essentially everything developers need to become
MSP experts.

In addition to providing a complete collection of existing MSP design resources, MSPWare also includes a
high-level API called MSP Driver Library. This library makes it easy to program MSP hardware. For more
information, see www.ti.com/tool/mspware.

Figure 16. Using TI Resource Explorer to Browse MSP-EXP430FR2433 in MSPWare

Inside TI Resource Explorer, these examples and many more can be found, and easily imported into CCS
with one click.

4.4 FRAM Utilities
The TI FRAM Utilities is a collection of embedded software utilities that leverage the ultra-low-power and
virtually unlimited write endurance of FRAM. The utilities are available for MSP430FRxx FRAM
microcontrollers and provide example code to help start application development.

4.4.1 Compute Through Power Loss (CTPL)
CTPL is a utility API set that enables ease of use with LPMx.5 low-power modes and a powerful shutdown
mode that allows an application to save and restore critical system components when a power loss is
detected.

4.4.2 Nonvolatile Storage (NVS)
The NVS library makes handling of nonvolatile data easy and robust against intermittent power loss or
asynchronous device resets. To keep data storage constant, the nonvolatile storage library contains
functions that store data in a way that is ensures recovery of the last valid entry without data corruption.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/tool/mspware
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4.5 MSP430FR2433 MCU

4.5.1 Device Documentation
At some point, you will probably want more information about the MSP430FR2433 device. For every MSP
device, the documentation is organized as shown in Table 8.

Table 8. How MSP Device Documentation is Organized

Document For MSP430FR2433 Description
Device family
user's guide

MSP430FR4xx and MSP430FR2xx
Family User's Guide

Architectural information about the device, including all modules and
peripherals such as clocks, timers, ADC, and so on.

Device-specific
data sheet

MSP430FR2433 Mixed-Signal
Microcontroller data sheet Device-specific information and all parametric information for this device

4.5.2 MSP430FR2433 Code Examples
MSP430FR243x, MSP430FR253x, MSP430FR263x Code Examples is a set of simple C examples that
demonstrate how to use the entire set of peripherals on the MSP4302433 MCU, including serial
communication, ADC10, Timer, and others, through direct register access. Every MSP derivative has a set
of these code examples. When starting a new project or adding a new peripheral, these examples serve
as a great starting point.

4.5.3 MSP430 Application Notes and TI Designs
Many application notes can be found at www.ti.com/msp430, along with TI Designs with practical design
examples and topics.

4.6 Community Resources

4.6.1 TI E2E™ Community
Search the forums at e2e.ti.com. If you cannot find your answer, post your question to the community.

4.6.2 Community at Large
Many online communities focus on the LaunchPad development kits – for example, www.43oh.com. You
can find additional tools, resources, and support from these communities.

5 FAQ
Q: I can't get the backchannel UART to connect. What's wrong?
A: Check the following:
• See Section 5.8.2 of the MSP Debuggers User's Guide for supported baud rates when using the eZ-

FET.
• Do the baud-rate settings in the terminal application on the host PC and the eUSCI match?
• Are the appropriate jumpers in place on the isolation jumper block?
• Probe on RXD and send data from the host. If you don't see data, it might be a problem on the host

side.
• Probe on TXD while sending data from the MSP. If you don't see data, it might be a configuration

problem with the eUSCI module.
• Consider the use of the hardware flow control lines (especially for higher baud rates).

Q: The MSP G2 LaunchPad kit has a socket that allows me change the target device. Why doesn't
this LaunchPad kit use one?
A: The target device on this LaunchPad kit does not come in the dual in-line package. Sockets for the
available device package are too expensive for the target price of this LaunchPad kit.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLAU739
http://www.ti.com/lit/pdf/slau445
http://www.ti.com/lit/pdf/slau445
http://www.ti.com/lit/pdf/slase59
http://www.ti.com/lit/pdf/slase59
http://www.ti.com/lit/zip/slac700
http://www.ti.com/msp430
https://e2e.ti.com
http://www.43oh.com/
http://www.ti.com/lit/pdf/slau647
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6 Schematics

Figure 17. Schematics (1 of 2)
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.



FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page


【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
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6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.
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IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated (‘TI”) technical, application or other design advice, services or information, including, but not limited to,
reference designs and materials relating to evaluation modules, (collectively, “TI Resources”) are intended to assist designers who are
developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you
(individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of
this Notice.
TI’s provision of TI Resources does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI
products, and no additional obligations or liabilities arise from TI providing such TI Resources. TI reserves the right to make corrections,
enhancements, improvements and other changes to its TI Resources.
You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your
applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications
(and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You
represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1)
anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that
might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you
will thoroughly test such applications and the functionality of such TI products as used in such applications. TI has not conducted any
testing other than that specifically described in the published documentation for a particular TI Resource.
You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include
the TI product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO
ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY
RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or
endorsement thereof. Use of TI Resources may require a license from a third party under the patents or other intellectual property of the
third party, or a license from TI under the patents or other intellectual property of TI.
TI RESOURCES ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO
ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL
PROPERTY RIGHTS.
TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT
LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF
DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL,
COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR
ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
You agree to fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-
compliance with the terms and provisions of this Notice.
This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, TI products and services.
These include; without limitation, TI’s standard terms for semiconductor products http://www.ti.com/sc/docs/stdterms.htm), evaluation
modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).
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